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Chapter 1

Getting started
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Waking up the system
To make a call you need to wake up the system from standby. However, if someone After wake-up, the screen will typically look like this:
calls you, the system will wake up by itself.
" ey s £0 poit he remote corirol towards the system o meke sure it discovers The dial-in address or ia-in nurmber of your systen .
youy P Y is displayed in the upper left corner. Date and time of day.

- The system will now display the wallpaper.

- The dial-in address or dial-in number of your system is displayed in the upper left

corner. If you have questions about the dial-in address or number, contact your
system administrator.

- The screen will also indicate if there are any calls you have missed.
Softkeys (described on the following pages).

If the system fails to respond to the remote control or to incoming calls, make sure that:
The system is connected to line voltage.
The remote control has working batteries.

The internal cables, such as the monitor cable and/or the camera cables are properly
connected, see the installation sheet for details, if needed.

D14852.04 User guide Cisco TelePresence Profile, C-series codecs, Quick Set C20, SX20 Quick Set.
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Overview of the
remote control

Microphone On/Off.

Adjust loudspeaker volume.

Use the Arrow keys to navigate in the
menus and the center V' key to confirm
your choice or selection.

When no menu is open, Arrow keys
can be used to move the camera.

Use this key to display the Main
menu on the screen.

Use this key to display the Phone
book (your contacts) on the screen.

Place a call.

Use this key to remove characters in
a text field.

Switch to show PC screen on the
system. Press again to go back to the
main camera.

Open the Presentation menu to
select other sources.

Zoom the camera.

Making calls

{

(@)

C

&
©
=
B
9
e

Phone book usage

>

Press and hold

y

Cisco TelePresence System Profile-series, C-series codecs, Quick Set C20, SX20 Quick Set

Getting started

In-call features

These keys correspond to the five context
sensitive softkeys along the bottom
of the screen.

bohi  Sikk  mnob

wxyz 9

7 pqrs 8 tuv

Scheduled meetings

Press and hold

abe/123 #

Press and hold

User guide

Advanced settings

Use this key to change the layout on
the screen.

Use this key to end an ongoing call.

Outside a call, press and hold to enter
the standby mode.

Use the keypad to enter letters and
numbers, as with a mobile phone.

Press a key repeatedly to access the
characters displayed on each key.

Press and hold the # key to switch
between touch tone mode (press
and hold), lower case characters and
numbers.

Use this key to enter touch tone mode
(DTMF) in a call. Press the V' key when
done.

When entering text this key is used to
toggle between upper and lower case
letters.

Press and hold to change between
characters and numerics.

Waking up the system

Grab the remote control and make sure your hand
touches the rubber line sensors located on both sides of
the remote control, or just touch any key on the remote

control.
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Navigating in the menus

Use the remote control to operate your video system. A few basic navigation - Inan input field, pressing C will delete characters/numbers to the left of the cursor

principles are all you need to know to get started. position.

- Press the Home key (@) to show the Home menu or wake up the system by lifting - When the system shows the Home menu only (see the Fig. below), pressing Home
the remote control. key (@) will hide the menu. To bring it back, press the Home key (&) again.

- The Arrow keys in the center of the upper part of the remote control are used to - Inan input field, pressing C will delete characters/numbers to the left of the cursor
navigate in the menus. position.

- When the system shows the Home menu only (see the Fig. below), pressing Home
key (@) will hide the menu. To bring it back, press the Home key (&) again.

Press the @ key to display the Home menu on the screen.

The element currently The little triangle
selected is indicated by an ) (. Call indicates that
orange rectangle. a submenu is
Use the a and v Arrow available.
keys to navigate up and
down in a menu.

sk )
. *  Meetings

i Presentation

J Camera control

x Settings

Example showing a submenu displayed by pressing the right arrow key.

& ca

458 Meetings Context sensitive softbuttons
& Presentation : corresponding to the function
& Camera control S| W &) Recent calts keys of the

A settings B & Acaanoter prticipant remote control.

Softbuttons not used in a
given context are shown
ghosted (gray).

Use the Home key (@) to exit all menus Use the €4 Arrow key to collapse the
and return to showing the Home menu menu expansion (to go back one
only. level).
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Entering text in text fields

Some menu fields expect text information to be entered. This is used to enter the
name, number or address of the person you want to call as well as for such things as
to search in the phone book and to maintain your list of contacts (the My contacts).

Text entry essentials

- If you press a number key when you are not in a call, the Call menu will be shown.

- The system will automatically switch to text mode (abc) inside entry fields expecting
text entries. The easiest and most convenient way of entering letters is by invoking
the on-screen virtual keyboard. Do as shown below to invoke the keyboard.

- You may also use the keypad in the same manner as when composing text
messages on a mobile phone, but the virtual keypad is by far more convenient and
it is also faster to use.

Add another participant

Add another participant

Press as shown to
produce the virtual
keyboard.

Press again to hide
the virtual keyboard.

- Press Function key number two from the left to invoke the virtual keyboard if it

does not appear by itself.

- Use the a Arrow key to move the cursor inside the keyboard.
- Use all four Arrow keys to move about the keyboard.
- When the required key is reached, press v to have the letter or digit inserted in the

entry field.

- If you navigate to the alpha/numeric selection field, pressing v/ will take you to

numeric from alpha and vice versa. Navigate and select inside here to the extent
needed. The same principle applies if you need to enter special characters.

- Once entered, press the Function key to hide the keyboard. This will put your entry

into effect.

Navigate to here

and click v to switch

% between letters and
digits.

Navigate to here Context sensitive
and click v/ to fields will appear
access special here. In this example
characters. you may start a call
from here.
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Screen layout

Making calls

The layout of the screen can be changed as shown to the right.
To show the display options screen, press the Layout (&H) key. Alternatively, you

may get to it through Settings > Layout.

Use the Arrow keys to move between the alternatives and use v to select the

alternative you want to use.

You may—or may not—include selfview (to show the outgoing video signal from
your own system). This will show you what others will see from your system.

In the Home menu, navigate down to
Settings and press the V' key.

& ca /’

. <

. *| Meetings -

a Presentation E

& Camera control ’

x Settings 3
A

Select between the options
available and press the

V key to leave the menu
putting your choice into
effect. See also p page

20 for more on this.

Layout
Main source: Camera

Call settings

In the Settings
submenu
navigate down
to Wallpaper.
Press V again.

Language: English
Date and time

Sounds and alerts
Wallpaper: Growing
System information
Administrator settings

Restart

Layout

Main source: Camera >
Call settings >
Language: English »
Date and time >
Sounds and alerts =
Wallpaper: Growing > O None

System information @ Growing

Administrator settings > O Summersky

Restart

Ry |

O Custom

Phone book usage

Cisco TelePresence System Profile-series, C-series codecs, Quick Set C20, SX20 Quick Set

Getting started

Layout

In-call features

SETTINGS

Scheduled mee

Layout control outside a
call is limited to the choice

Main source: Camera
Call settings
Language: English
Date and time

Sounds and alerts

LAYOUT CONTROL

Show selfview

between showing selfview
and showing a wallpaper...

However, if you
already have
activated the

selfview, the menu
will give you these

e |

Layout

® _. Wallpaper

SETTINGS

options when you
enter the menu
again.

Layout control when in a
call provides the choice

Main source: Camera
Call settings
Language: English
Date and time

Sounds and alerts

Show selfview

of showing selfview or full
screen participant...

However, if you
already have
activated the

selfview, you may
select where the
selfview should

LAYOUT CONTROL

e |

® _. Full screen participant

appear in the image
when you enter the
menu again.

Change remote layout (the outgoing video) when hosting

MultiSite Conference...

& Show selfview

o _3 Fullcreen partcipant

tings

Layout

User guide

Advanced settings

SETTINGS

e |

Main source: Camera >
Call settings »

Language: English

LAYOUT CONTROL

/ Hide selfview

=
4]

Wallpaper with selfview

- Full screen selfview

SETTINGS

Layout

x|t il

Main source: Camera >

Call settings >

Language: English >
LAYOUT CONTROL

‘ Show selfview

® “I Speaker participant
© __,J
S

Full screen participant

Pressing Layout

(@H®) will produce a
softkey letting you
choose the layout

of the outgoing

video. Select among
all defined layouts
available. Note that
you have no influence
on the actual layout on
the remote system.
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Camera presets

Using the presets

& ca & Pos.1

You may create predefined settings of where the camera points and the zoom. This
is referred to as camera presets. See the next page for more.

CAMERA PRESETS

—-— "
- Meetings Pos. 2
i Presentation Pos.3

3 Camera control

x Settings

Edit camera preset

Camera presets must have been defined before you
do this.

Press the @ key on the remote control to display the
Home menu and select Camera control. Use the a and
v Arrow keys to navigate in the menu. Use V to select
a preset. The camera will now move accordingly. Note
that this feature may be used any time.

Where to find camera presets

N
e ()5 =]

Camera presets must have been defined
before you do this.

Press the @ key on the remote control to
display the Home menu and select Camera
control. Use the 0~9 keys to select a preset.
The camera will now move accordingly. Note
that this feature may be used any time.
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LAYOUT CONTROL

A Show selfview

Wallpaper

Outside a call, press the
Layout key and select Show
selfview followed by the v/

your system.

e This will display the softkeys along the bottom of the 6
screen, as shown.

Display the Camera presets
menu by pressing the Function
key corresponding to the
Camera presets softkey on
the remote control to open the

key, if needed. You will now Adjust pan, tilt and
see the outgoing video from zoom, as required.

CAMERA PRESETS
EE Pos.2
WA Pos.2
Pos.3

Edit camera preset

In the Camera presets menu
navigate to Edit camera preset
and press the v/ key.

In-call features

User guide

Scheduled meetings Advanced settings

& ca

-
| Meetings

u- Presentation

& Camera control

A settings

Press the @ key to display
the Main menu and
navigate to

Camera control.

Press the Vv key.

SET CAMERA PRESETS
Default

Zoom out

Whiteboard

CAMERA PRESETS I" Not defined

Not defined

B E

il Default
Not defined
@& Zoom out
Not defined
Whiteboard
Not defined

Edit camera preset >

Not defined

Navigate to the undefined
preset you would like to define.

When you have located it,
press the vV key.

menu. Any presets already existing are
listed here.
D14852.04 User guide Cisco TelePresence Profile, C-series codecs, Quick Set C20, SX20 Quick Set. 10 .
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The virtual
keyboard will now
automatically be
invoked by the
system.

CAMERA PRESETS

&l Default
& Zoomout

&R Whiteboard

ERERRERDNE

Edit camera preset

4:NEW PRESET

Cancel

Default

Zoom out

Whiteboard

Not defined

Not defined

Not defined

Not defined

Not defined

Not defined

EDIT CAMERA PRESETS 4:NEW PRESET

Cancel

Making calls

Phone book usage

Cancel

Use the A Arrow key
as shown to move
the cursor up into the
virtual keyboard (the
cursor is indicated by
an orange square).

Press the V' key to put your
changes into effect. This
will be confirmed by the
system.

In-call features

Scheduled meetings

4:NEW PRESET

Name

Cancel

Give the new preset a
descriptive name.

Use the Arrow keys to
move about the keyboard
and the v key to select a
character.

Access special characters
and numerics by means of
the corresponding keys.

SET CAMERA PRESETS
Default

Zoom out

Whiteboard

charlie watts

Not defined

Not defined

Not defined

Not defined

EERERERYE

Not defined

User guide

Advanced settings

Press the ¥ Arrow \‘x
key a sufficient number To leave the menu, press
of times to move the G ToTer] the @ key.
cursor down to Save new Alternatively, you may
preset, as shown. define another preset or
redefine existing (see the
following page for more).
D14852.04 User guide Cisco TelePresence Profile, C-series codecs, Quick Set C20, SX20 Quick Set. ' .
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LAYOUT CONTROL

A Show selfview

Wallpaper

Outside a call, press the
Layout key and select Show
selfview followed by the v/
key, if needed. You will now
see the outgoing video from
your system.

e This will display the softkeys along the bottom of the
screen, as shown.

Display the Camera presets
menu by pressing the Function
key corresponding to the
Camera presets softkey on
the remote control to open the
menu.

Making calls

e

Phone book usage

Adjust pan, tilt and
zoom, as required.

CAMERA PRESETS
EE Pos.2
WA Pos.2
Pos.3

Edit camera preset

In the Camera presets menu
navigate to Edit camera preset
and press the v/ key.

Any presets already existing are
listed here.

In-call features

User guide

Scheduled meetings Advanced settings

(’ Call

™ Meetings

Q Presentation

& cameracontrol

x Settings

Press the @ key to display
the Main menu and
navigate to

Camera control.

Press the V' key.

SET CAMERA PRESETS

Default

Zoom out

Whiteboard

CAMERA PRESETS Not defined

Not defined
&R Default

Not defined

A Zoom out
Not defined

Whiteboard
Not defined

Edit camera preset >

Not defined

Navigate to the existing preset
that you would like to redefine.

When you have located it,
press the vV key.
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EDIT CAMERA PRESETS 3:WHITEBOARD

Default Update to current camera position

Zoom out

Delete preset
Whiteboard

Not defined Cancel

CAMERA PRESETS
Not defined
&l Default
Not defined
& Zoomout
Not defined
Whiteboard
Not defined

Edit camera preset

ERERRERDNE

Not defined

Navigate to:

Update to current camera position to
redefine the preset

Delete preset to remove it from the list

Cancel to prepare to leave the menu
undoing any updates.

Phone book usage

Press the V key to put your
changes into effect. This
will be confirmed by the
system.

In-call features

Scheduled meetings

User guide

Advanced settings

D14852.04 User guide Cisco TelePresence Profile, C-series codecs, Quick Set C20, SX20 Quick Set.

All contents are copyright © 2010-2013 Cisco Systems, Inc. All rights reserved. TC 6.1 06.2013

« = P

www.cisco.com



CIsco Cisco TelePresence System Profile-series, C-series codecs, Quick Set C20, SX20 Quick Set
Contents Making calls Phone book usage

Camera settings

Camera settings let you adjust the exposure and whitebalance.
Do as follows:

1.Press the [2B key on the remote control to display the Layout menu. Select Selfview
to be shown as required.

CAMERA SETTINGS

Exposure >

Whitebalance >

If you change the Brightness
mode to Manual, the
Brightness level becomes
possible for you to set. Since
Auto has been chosen here,
the actual level is shown
ghosted.

EXPOSURE/

Brightness mode: Auto >

Brightness level: 1

Backlight: Off

Backlight compensates for any backlight shining on
the camera from behind you. Such light conditions
will tend to make you appear darker than needed.

User guide

In-call features Scheduled meetings Advanced settings

2.Press the @ key to display the Home menu and select Camera control.

3.This will cause softbuttons to appear. Press the Function key corresponding to
Camera settings (Function key number 2 from the left).

4 Follow the procedures outlined below.

CAMERA SETTINGS

Exposure >

Whitebalance >

WHITEBALANCE

Whitebalance mode: Manual

Whitebalance level: 1

Since the whitebalance has been set to Manual in this case, you will have access to
setting the whitebalance in the usual manner. Use Automatic if that is more convenient.
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Call settings—an overview

Use the Call settings menu to set the default bit rate and how the system shall answer
incoming calls. Answering can be set to automatic or to manual. More on this can be
found on the next page.

Do as follows:
1.In the menu select Settings > Call settings and expand the submenu.

You may choose what to use as the main input source. This will typically be the
camera, a secondary camera (if applicable), the PC input or other sources such as a
DVD player.

Do as follows:
1.In the menu select Settings > Main source and expand the submenu.

2.Use the Arrow keys to move between the alternatives and use v to select the
alternative you want to use.

3.Collapse the menu using the < Arrow key.

2.Use the Arrow keys to move between the alternatives and use v to select the
alternative you want to use.

3.Collapse the menu using the < Arrow key.

& ca & ca
** Meetings ™ Meetings
u. Presentation u. Presentation Layout
L. t Main source: Camera
& cameracontrol ayou & cameracontrol CALL SETTINGS
3 . Main source: Camera 3 . I Call settings
A setings ® Camera A setings : Auto answer mode: On
Call settings Language: English
Language: English O Pc Date and time Auto answer delay: 5 sec

Date and time
Sounds and alerts
Wallpaper: Growing
System information

Administrator settings

Restart

This example has been
taken from a Codec C20
equipped Profile. Larger
systems may have more
options.

More on Profile systems
and their codecs can be
found on P page 30.

Sounds and alerts
Wallpaper: Growing
System information

Administrator settings

Restart

Auto answer mute: Off

Do not disturb mode: Off

Default callrate: 4000 kbps
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Call settings—auto answer options

You may set up your system to answer automatically whenever someone calls you.
If you choose to do so, you may also specify how long time it shall take before your
system connects you.

For privacy reasons you may want your microphone to be muted (turned off) when the
system answers automatically. Alternatively, you may set the system to Do not disturb.

CALL SETTINGS

Auto answer mode: On

Auto answer delay: 5 sec

Auto answer mute: Off
Do not disturb mode: Off

Default callrate: 4000 kbps

Auto answer mode: On

Auto answer delay: 5 sec

ol 1A AT AN

Auto answer mute: Off
Do not disturb mode: Off >

Default callrate: 4000 kbps

Auto answer mode: On

Auto answer delay: 5 sec

I Auto answer mute: Off @ On
Do not disturb mode: Off O off
Default callrate: 4000 kbps
Auto answer mode: On
Auto answer delay: 5 sec >
Auto answer mute: Off
Do not disturb mode: Off ® on
Default callrate: 4000 kbps O off

Set to On to have your
system answer incoming
calls automatically and Off to
answer them manually.

Use the 4 and » Arrow keys
to alter how long time it shall
take before your system
connects you. Interval is 0-50
seconds.

For privacy you may set the
microphone to be muted upon
autoanswer. You will then have to
activate the microphone yourself
(press #).

To further enhance your privacy
you may set the system to Do
not disturb. Your system will then
not respond to incoming calls. As
soon as you disable the Do not
disturb any call attempts made
while the feature was enabled
will be listed as missed calls.

User guide

In-call features Scheduled meetings Advanced settings

Call settings—default call rate

The Call settings menu lets you set the default call rate expressed as default number
of kilobits per second.

You may want to consult your system administrator to discuss the best setting in your
environment.

Layout

Main source: Camera > O 384
Call settings > O 512
Language: English O 768
‘. Auto answer mode: On > O 152
O 1472 |
fassa Auto answer delay: 5 sec >
= O 1920
i Auto answer mute: Off >
O 2560
= Do not disturb mode: Off >
o O 3072
x Default callrate: 4000 kbps > @ 4000

Scroll with the a and v Arrow
keys to access settings not
shown.

Options are 128, 256, 384, 512, 768 (initial default), 1152, 1472, 1920,
2560, 3072, 4000 and 6000 bits (not shown in Fig.) per second.
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Language settings About the setting of date and time
This will allow you to specify the language used in the menus and settings shown. The You may have the system pick date and time for you or you may specify date and time
following languages are supported: English, Norwegian, Swedish, German, French, zone settings along with date and time format and the date and time of day itself.
ltalian, Japanese, Russian, Spanish, Korean, Finnish, Chinese (Simplified), Turkish, Do as follows:

Polish, Hungarian, Czech. 1. Start from the Home menu and navigate down to Settings and press the v/ key.

Do as follows: Then navigate to Date and time and press the v key. Select between NTP. mode Off,
1. Start from the Home menu and navigate down to Settings and press the v key. Auto and Manual.
2. Then navigate to Language and press the v key again. Use the a and v Arrow keys Off: NTP mode is disabled—you will then have to specify date and time
to select. Auto: The system locates the NTP server itself
3.Press the v key to exit the menu putting changes into effect or the Manual: You must specify the path to the NTP server.

< i . . . .
Arrow key to leave the menu going one step back 2.Press the v key to exit the menu putting changes into effect or the

< Arrow key to leave the menu going one step back.

Further details are shown on the next page.

mi O onmess

L. t
ayou *1 @ English
Main source: Camera > O French SETTINGS
Call settings >
- g O German Layout
Language: English
Rl v > O ltalian Main source: Camera >
, Date and time > X
O Japanese Call settings >
e, Sounds and alerts > - X
B O Korean Language: English
Wall, : Growi >
i allpaper: Growing O Norwegian ‘0
System information NTP mode: Auto > O off
2 Y intermat O Portuguese o °
= L . s Auto
Administrator settings
g > O Russian g
Restart i ) ) O Manual
x estay O Spanish Time zone: GMT-12:00 (International  »
3 Date format: Day. Month, Year >
Scroll with the a and v Arrow
X Time format: 24 hours >
keys to access languages not
shown.
D14852.04 User guide Cisco TelePresence Profile, C-series codecs, Quick Set C20, SX20 Quick Set. 17 .
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Setting date and time yourself

You may specify date and time zone settings along with date and time format and the

date and time of day itself.
Do as follows:

1. Start from the Home menu and navigate down to Settings and press the vV key.

Then navigate to Date and time and press the v key.
2.Use Arrow keys and the v key to set everything as required.

NTP server: Off

Day: 10 >

Month: September >

Year: 2010 >
Time: 13:37 >
Date format: Day, Month, Year >

Time format: 24 hours

The options shown here are
available when NTP server Off has
been chosen only.

|

5

D

[

O Year.Month.Day (yyyy.mm.dd)

(O Month.Day.Year (mm.dd.yyyy)

@ Day.Month.Year (dd.mm.yyyy)

@ 24hours

O 12 hours (am/pm)

Phone book usage In-call features Scheduled meetings Advanced settings

Setting date and time automatically

You may have the date and time of day set automatically. If you set NTP server to
Auto, the system will take care of the connection to the NTP server itself.

If you set it to Manual, you must specify the path to the NTP server.
At any rate, you must still specify time and date formats as well as the time zone.

Scroll with the a
and v Arrow keys
to access settings

not shown.

DATE AND TIME

NTP server: Auto

>

Time zone: GMT-11:00 (Midway Island »

O GMI-06:00..,

Date format: Day. Month, Year >

Time format: 24 hours > O Year.Month.Day (yyyy.mm.dd)

(O Month.Day.Year (mm.dd.yyyy)

@ Day.Month.Year (dd.mm.yyyy)

@ 24hours
O 12 hours (am/pm)

DATE AND TIME

NTP server: Manual 2.ntp.somewhere.cu.no

Setting NTP server to Manual
lets you specify the path to
the NTP server. Otherwise
nothing is different from the
Auto setting.

Save

NTP server: 2.ntp.somewhere.cu.no

Cancel

Time zone: GMT-11:00 (Midway Island
Date format: Day, Month, Year

Time format: 24 hours
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Getting started

Selecting ring tone

Making calls

The system lets you choose between a multitude of ring tones.
Do as follows:
1. Start from the Home menu and navigate down to Settings and press the v key.

2.Then navigate to Sounds and alerts and press the v key. Navigate to Ring tone and
press the v key. Use the a and v Arrow keys to move among the ring tones. Each
ring tone will be played when you position the cursor at it.

3.Press the v key to exit the menu putting changes into effect or the
< Arrow key to leave the menu going one step back.

SETTINGS
Layout >
Y i @ Marbles
Main source: Camera >
O IceCrystals
Call settings > )
- O Polaris
Language: English >
9tas o O Alert
{. Date and time >
- O Discreet
e Sounds and alerts 4
Mt O Fantasy
R SOUNDS AND ALERTS
i Ring tone: Marbles > © Jazz
- O Nordic
3 Ring tone volume: 40 >
O Echo
X Key tone: On >
O Rhythmic

Cisco TelePresence System Profile-series, C-series codecs, Quick Set C20, SX20 Quick Set

Phone book usage

User guide

In-call features Scheduled meetings Advanced settings

Setting ring tone volume

The system lets you set the ring tone volume.
Do as follows:
1. Start from the Home menu and navigate down to Settings and press the Vv key.

2.Then navigate to Sounds and alerts and press the v key. Navigate to Ring tone
volume and press the v key. Use the 4 and » Arrow keys to set the volume.

3.Press the v key to exit the menu putting changes into effect or the
< Arrow key to leave the menu going one step back.

SETTINGS

Layout
Main source: Camera >
Call settings >
Language: English >
Date and time >

(=N Sounds and alerts >

~ SOUNDS AND ALERTS

Ring tone: Marbles >

Ring tone volume: 40 >

« [T -

‘ Key tone: On

D14852.04 User guide Cisco TelePresence Profile, C-series codecs, Quick Set C20, SX20 Quick Set.
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Setting key tone to on or off Setting wallpaper on your screen
The system may be set to emit a sound when you press a key on the remote control The system lets you set a wall paper on your screen. This is shown in idle condition
inside the dialing dialog menu. only.
Do as follows: Do as follows:
1. Start from the Home menu and navigate down to Settings and press the v key. 1. Start from the Home menu and navigate down to Settings and press the v key.
2.Then navigate to Sounds and alerts and press the v key. Navigate to Key tone and 2.Then navigate to Wallpaper and press the v key. Use the a and v Arrow keys to
press the v key. Use the a and v Arrow keys to select. select wall paper. Uploading and inserting a custom wallpaper is explained overleaf.
3.Press the v key to exit the menu putting changes into effect or the < Arrow key to 3.Press the v key to exit the menu putting changes into effect or the < Arrow key to
leave the menu going one step back. leave the menu going one step back.

SETTINGS

Layout

Layout

Main source: Camera > Main source: Camera >

Call settings >

Call settings >
Language: English > - Language: English >
Date and time > (. Date and time >

Aas Sounds and alerts >

Sounds and alerts

O None

Wallpaper: Growing

Ring tone: Marbles

@ Growing

Ring tone volume: 40

i System information

Administrator settings > O Summersky

Restart

> %@

O Custom

Key tone: On
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Inserting your own wallpaper System information
The system lets you upload and use your own wallpaper (for example your logo) on System information can be listed.
your screen. This custom wallpaper picture can be any size up to 1920x1200 pixels. Do as follows:
The custom wallpaper is uploaded by means of the system’s web interface. See the 1. Start from the Home menu and navigate down to Settings and press the v key.

Appendices section of the Administrator Guide for your system for further details
about the web interface.

Do as follows:

1.0pen a web browser and enter the IP address of the codec/endpoint of your
system.

2.Select Wallpaper from the menu bar on the left side of the screen.

3.Browse for the file and click the Upload button.

4.Close the web browser.

5.Select Custom wallpaper (see the previous page) to put the change into effect.

2.Then navigate to System information and press the v key again.
3.To exit this screen, press the Home key (@ ).

: . >~ A shortcut to this function is available. Make sure the system displays the Home
Note that access to the system’s web interface may have been password protected W~ menu (press the & key on the remote control to display this menu). Then press the
by your administrator. rightmost softbutton to display the System information.

stem information Call status
URI

D14852.04 User guide Cisco TelePresence Profile, C-series codecs, Quick Set C20, SX20 Quick Set. 4 21 >
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Entering the Advanced configuration

Your video system has a separate set of Advanced configuration settings intended
to be used by system administrators only. These settings may be protected by a
password.

Aspects of the Administrator settings are discussed in more detail in the section
“Advanced settings” on page 44.

A full presentation of the Administrator settings can be found in the Administrator
Guide for your system, available separately for download from Cisco.com.

SETTINGS SETTINGS

Layout Layout

Main source: Camera Main source: Camera

Call settings Call settings

Language: English Language: English

Date and time
ADMINISTRATOR PASSWORD

Date and time >

Sounds and alerts >

Please enter your

. i >
Wallpaper: Growing Administrator password:

*xk

System information

LY |

Administrator settings

Restart
Cancel

Restarting the system

Some changes in the system settings, network settings and the infrastructure
configurations may call for a system restart.

Do as follows:

1. Start from the Home menu and navigate down to Settings and press the v key.
2.Then navigate to Restart and press the v key.

3.Use Arrow keys and the v key to make your selection.

Layout
Main source: Camera

Call settings

Language: English

Date and time d
Sounds and alerts >
Wallpaper: Growing >

System information

TRy

Administrator settings

Restart

O

Restart

Do you really want to restart the system?

Restart

Cancel
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Chapter 2
Making calls
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User guide

Advanced settings

& ca

P )
Meetings

u Presentation

i B Phone book S
o
A

& Camera control

A Settings

B Phone book

@) Recentcalls @) Recentcalls

Add another participant Add another participant

Press the @ key to display
the Main menu.

Press as outlined to invoke

Use the A Arrow key, as shown, to
the virtual keyboard.

move the cursor up into the virtual
keyboard (indicated by an orange
square).

Hedda Gabler
& cal

ﬂ Phone book

@ Recent calls

Add another participant

alice.wonderland@everywhere.co.nl
norah.dollhouse@somecompany.com

Dorian Grey

Dorian Grey
Hedda Gabler

Hedda Gabler

Floria Tosca Floria Tosca

Use the Arrow keys to move about the

Press the ¥ Arrow key a sufficient
keyboard and the v key to select a character.

number of times to exit the keyboard

Press ¢* or the v key to

: ; actually place the call.
Access special characters and numerics by and enter the list of matches (if such

means of the Corresponding ke\/s_ a list appeal’S). Then use the Arrow

Matches will appear as you write keys to navigate to the one to call and

press the v key.
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PHONE BOOK
Search

W My contacts

W 0.1-Beijing Office

% 0.2 - London Office
W 0.3 - New York Office
W 0.4 - Oslo Office

W 0.5 -San Jose Office

% 0.5 - Washington Office

Press the @ key to display the Phone book.
This will also invoke the virtual keyboard.
Your phone book may contain folders, as
outlined.

Any search you make will include current
folder and any subfolders, so if you stay at

Phone book usage In-call features

PHONE BOOK

W My contacts

& 0.1- Beijing Office

& 0.2 - London Office

& 0.3 - New York Office
& 0.4 - Oslo Office

& 0.5-San Jose Office

& 0.5 - Washington Office

Use the A Arrow key, as shown, to
move the cursor up into the virtual
keyboard (indicated by an orange
square).

User guide

Scheduled meetings Advanced settings

PHONE BOOK

Search |a

Abraham Anderson

Adrian Jones
Harry P. Otter
Hedda Gabler
Norah Dolthouse
Peer A. Gynt

Roberta Nielsen

Use the Arrow keys to move about
the keyboard and the v key to
select a character.

Access special characters

and numerics by means of the
corresponding keys.

the top level (sometimes referred to as the
root level), your search will be made within
all (sub)folders.

Matches will appear as you write,
as outlined.

Call the entry selected (press ¢* or the v key).
Harry P. Otter

harry.p.otter@somecompany.com

“Call

Edit before call

Search |a

Abraham Anderson

Edit the entry (for example insert a prefix)
Adrian Jones and then call.
Harry P. Otter

Hedda Gabler

Save the entry to your

Save to my contacts X
personal list of contacts.

Norah Dollhouse
Peer A. Gynt Add to participants list

Roberta Nielsen

View dialing method

Add to list of participants in a multisite call
(optional feature).

Exit the virtual keyboard as explained on the
previous page.

Navigate to the entry to be called and press
the v key or the P Arrow key to produce the
options available.

View dialing method options
(H.323 and SIP wherever applicable).

More about the phone book can be found in the section “Phone book usage”—click on the topic on the menu line at the top of this page.
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« harry.p.otter@somecompany.com
Received 20.061116.29
& cau hedda.gabler@somecompany.org & |
Placed 2006111510

N

dorian.grey@myself.net
Vised 2004 11435

Meetings

u Presentation

& ca

« frodo,b.aggins@myshire.org
Received 20.06.112.20

B Phone book

«;; Recent calls

floria.tosca@somecompany.org
Placed 200611017

J Camera control

x Settings

Add another participant

Press the @ key to display
the Main menu.

Navigate down to Recent calls
and then press the V key.

Use the Arrow keys to navigate in
the list.

Call the entry selected (press ¢% or the v key).
Harry P. Otter

harry.p.otter@somecompany.com

“Call

Edit before call

Edit the entry (for example insert a prefix)
and then call.

Save the entry to your
personal list of contacts.

Save to my contacts

Add to participants list

View dialing method

Add to list of participants in a multisite call
(optional feature).

View dialing method options
(H.323 and SIP wherever applicable).
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When someone is calling you

Contents

Press the ¢* key
on the remote

control to answer
an incoming call.

Press the

== key on the
remote control to
reject an incoming

Press the == key on the remote
control to terminate an ongoing
call.

call.

Management systems booking list

If your video network makes use of the Cisco Telepresence Management System
(TMS), your video system may be set up for scheduled meetings from remote.

Typically, the TMS works with tools like Microsoft Outlook, permitting employees to
book and schedule video calls and conferences.

Any bookings applicable to your system will appear on the screen as shown in the
below example.

john.doe@videocompany.co.nla

|

TODAY'S BOOKINGS
NOW - 14:30
14:30 - 15:00

15:00 - 15:30
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| Makingcalls |
Calling more than one (optional)

Provided that your video endpoint is equipped with the optional built-in Multisite
feature, any point-to-point video call (a call involving two parties only) may be
expanded to include additional participants. The call will then become a video
conference.

Any ongoing video call can then be expanded to a video conference by adding more
participants at all times (see the right example).

Alternatively, you may set up a list of whom to call before you actually call them and
then call them all in one go (see the below example).

Note that your video network may have an infrastructure permitting video conferencing—
even if your video system itself does not. This will require the presence of an external
Multipoint Control Unit (MCU).

The most advanced video systems (those using Codec C60 or C90) can—when
equipped with Multisite—set up video meetings with four participants (yourself
included). External MCUs may let you set up conferences with many more
participants.

Systems equipped with Codec C20 have no Multisite feature (see P> page 30 to
find out which type of codec your system has). However, all products described in this
user guide come with Multiway™ installed (see the next page for more on this).

Contact your system administrator for details on how to use external MCUs.

This example shows two entries made before any
calls are placed.

To do this start by entering the first person to call
(directly, via the recent calls list or from the phone
book), then select Add another participant and add
a second person. When all have been entered,
press Call on the remote control or select the Call
icon in the menu.

alice.wonderland@mycompany.com »

‘john.doe

For units equipped with MultiSite capabilities, up to
three participants can be called simultaneously, if
no external MCUs are used.

After you have entered the participants, press
the ¢® key to place the calls. Any of these may,

of course, be fetched from the phone book in the
usual manner.

Phone book usage

Cisco TelePresence System Profile-series, C-series codecs, Quick Set C20, SX20 Quick Set

In-call features

During a call, open the Call menu again...

(2]

Then call someone in the usual manner—
by keying in the name, number or address
(in this case “542") or by means of the
phone book. Invoke the virtual keyboard
(see p “Entering text in text fields” on
page 7), if convenient.

©

Finally, navigate down to ¢* Call and
place the call...

If you want to add another participant,
repeat the process. The maximum
number of participants possible
depends on your system’s configuration.

The host of a video conference is the

one who initiated the conference. This
is the endpoint to which all the others

are connected.

The host has the right to terminate the
connection to any of the participants.
The participants cannot control any

of the others, but may disconnect
themselves from the meeting at all
times.

Scheduled meetings

User guide

Advanced settings

+  alicewonderland@mycompany.com

| This is the
participant
& cal you already
E Phone book areina Ca”
with.
@ Recent calls
: Add another participant
& alicewonderland@mycompany.com
542
| The next
& ca participant
E Phone book \/OU are
going to
@ Recent calls Ca”

& Addanother participant

& alice wonderland@mycompany.com

[542

I (. Call
E Phone book

@ Recent calls

Gy Use this

to place
the call.

0 .
- Add another participant

[ ]
End call

Do you really want to disconnect this call?

I Disconnect all

alice. com

Disconnect 542

Cancel
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. . ™
Using Multiway™ to call more than one

Someone calls you while you are in a call. You will need to decide whether the calling party

All systems described in this User guide offer Multiway as a means to call more shall be invited to join the current call or not.
than one. Note that successful use of Multiway requires the presence of certain © Someone calls you while you are in a call. A dialog box giving you three options will be
infrastructure products. If in doubt check with your system administrator. shown.

't

Incoming call

norah.dollhouse@somecompany.com

550092

Accept (put current call on hold)

‘Accept (disconnect current call)

Reject

Assume that you already are in a call and that you would like to expand the call to include @ Select Accept (put current call on hold).
someone else.

Do as follows: ©® When you are ready to create the conference, select Join Calls.
© start calling someone else by pressing the ¢ orthe 4 key on the remote control. 5

alice.wonderland@everywhere.co.nl

norah.dollhouse@somecompany.com

Dorian Grey
Hedda Gabler

Floria Tosca Callon hold

Your call with
james.dowe@somecompany.com
is on hold,

@ Enter the number or URI of the person to be included, either directly or by means of the \
phone book or the list displayed) and place the call by pressing the v/ key. This will put T T
the current call on Hold. When the new participant replies, select Join Calls.

O Al three of you will now be in the same meeting.

Case 2 options: If you do not want to set up a Multiway conference, you have the following
choices in 2. above:

If you want to accept the incoming call instead of the current call, select Accept
(disconnect current call).

If you do not want to respond to the incoming call, select Reject.

Callon hold

Your call with
james.dowe@somecompany.com
is on hold.

\\‘/{
’/@:

The maximum number of participants in a Multiway call is limited by the capabilities of the
9 All three of you will now be in the same meeting. infrastructure of your network only. The two cases described on this page may be combined
as much as you want.

9 Repeat to include more participants if needed.
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Which codec does my system have?

The optional ability to call more than one participant—the MultiSite feature— does At any rate, MultiSite is an optional feature that may—or may not—be present in your
not apply to all video endpoints. This depends on the type of codec your system is endpoint.
equipped with. The following applies:

If you need to see which type of codec your system is equipped with, open the
- Endpoints using Codec C40, C60, C90 and SX20 support MultiSite and MultiWay. bottom module lid of the system.

- Endpoints using Codec C20 do not support MultiSite, but MultiWay.

- Quick Set C20/C20 Plus both use the Codec C20. Consequently, they do not
support MultiSite, but MultiWay.

- SX20 Quick Set use the Codec SX20 and supports both MultiSite and MultiWay.

Looking for codec type: Codecs:

Codec C90
Open the bottom module lid as %
shown, to see which type of Codec C60

codec you have.

Codec C40

Codec C20

Codec SX20
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Chapter 3
Phone book usage
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Basic phone book features

Your video system contains a phone book. The phone book is organized in a way very

similar to what you find in a mobile phone.

It contains a section where you can add your own list of contacts, and most corporate

solutions will also include a corporate phone list. o
This corporate phone list is normally installed and maintained from remote by your

system administrator through a management system like the Cisco Telepresence
Management Suite (TMS), which is available separately.

You cannot edit the corporate list yourself, but you may add entries to My Contacts.
These may be edited as much as you want.

Press the 4 key...

.. the Phone book menu will now open...

PHONE BOOK

9 Folders contain

. . . Search

Navigate in the phone book with the PHONE BOOK phone book

Arrow and V/ keys. Search entries (and they w My contacts >

The phone book may contain folders i b mre (Y UG ol 0.1 - Beijing Office >
indicated by folder icons (@). Press w 0.2-London Office subfolders). 0.2 - London Office .
the » Arrow key to display the New York Office %&

contents of a folder. Repeat, if needed, Osto Office 0.3 - New York Office >

if there are more folder levels. San Jose Office 0.4 - Oslo Office >

Washington Office

Whenever you are at a lower level, use
the € Arrow key to move one level
back.

Searching for an entry is explained on
the next page. The phone book typically contains your own My contacts and a corporate phone book.

You may create your own list of contacts in My contacts.

0.5 - San Jose Office >

E & £ B £ &

0.5 - Washington Office

9 The phone book can |
PHONE BOOK also be accessed
When an entry is located, just press search [a from the Call menu. & ca

Abraham Anderson

Adrian Jones
Phone book
Harry P. Otter

&y») Recentcalls

the €° key to place the call.

Hedda Gabler

Norah Dollhouse

Peer A. Gynt

Add another participant

Roberta Nielsen
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Searching in the phone book

The My contacts may contain up to 200 entries, but the entire phone book can be
virtually unlimited in size. Consequently, using the arrow keys as the only navigation
device can easily mean a lot of work. What to do?

Enter the search function. By means of a virtual keyboard the search procedure is a
simple and convenient way of locating an entry.

Your phone book may contain folders, as outlined. Searches made will include current
folder and any subfolders, so if you stay at the top level (sometimes referred to as the
root level), your search will be made within all the (sub)folders.

Cisco TelePresence System Profile-series, C-series codecs, Quick Set C20, SX20 Quick Set

Phone book usage

@
a
g

N
s

T
@

]

HEEH
Fl El EL L
I E] ) B

In-call features

PHONE BOOK
seren [ ]
W My contacts >
w 0.1- Beijing Office

W 0.2-London Office

W 0.3-New York Office

® 0.4-0slo Office

= 0.5-San Jose Office

= 0.5 - Washington Office

+fafs]af[r]a]n

=
i|e

Search

= Mycontacts >
= 0.1- Beijing Office

= 0.2-London Office

® 0.3 New York Office

w 0.4-OsloOffice

= 05-San Jose Office >

= 0.5 - Washington Office >

PHONE BOOK
s i ]
| Abraham Anderson >
Adrian Jones >
Harry P. Otter
Hedda Gabler
Norah Dolthouse
Peer A.Gynt

Roberta Nielsen

Add more letters to narrow and refine your search.

Example: Keying in da, will return entries like Dave Olson and David Jones, but also John
Dahl and Vittorio Dalmazzino. There is no case sensitivity.

Scheduled meetings

User guide

Advanced settings

Press the M key to display
the Phone book. This will also
invoke the virtual keyboard.

Use the A Arrow key as
shown to move the cursor
up into the virtual keyboard
(indicated by an orange
square).

Use the Arrow keys to move
about the keyboard and the v/
key to select a character.

Access special characters
and numerics by means of the
corresponding keys.

Matches will appear as you
write, as outlined.

How to call the selected
entry is shown in the section
“Making calls”.
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Making calls

Adding new contacts to the phone book

New contacts can be added to My contacts only. Other entries must be entered by

your system administrator.

While you are inside the phone book or inside the list of recent calls, navigate to the entry
you would like to copy to My contacts and press the V4 key or the » Arrow key to show the

Options menu:

harry.|

Recaived 2
» hedda.gabler@somecompany.org
")

Placed 20041115,

E.oner@somecompany.com
Genié29

dorian.grey@myself.net
Viosed 20540135

> floria.tosca@somecompany.org
Placed 006 1105.7

Harry P. Otter

harry p.otter@somecompany.com

Call

Edit before call

Save to my contacts
Add to participants list

View dialing method >

SAVETO MY CONTACTS

Name Harry P. Otter b
Number / URI [H323:harry.p.otter

Save

Cancel

Navigate down to Save to my contacts and press the V4 key to open the dialog box that allows

you to edit the entry, if needed.

This is similar to entering a new contact manually (see right for details), but in this case the
name and number or address (URI) of the copied contact has already been filled in for you
by the system. If you want to edit the information entered, you may do so. Remember to save

before leaving the menu.

Phone book usage In-call features

Scheduled meetings Advanced settings

o Open the phone book by pressing the (AA] key on the remote control and
navigate to My contacts:

PHONE BOOK
Search
I w My contacts >
w 0.1- Beijing Office >
w 0.2-London Office >
w 0.3 - New York Office >
w 0.4 - Oslo Office >
w 0.5 - San Jose Office >
w 0.5 - Washington Office >

Search My contacts

“ & Add new contact

10.47.148.797
Adrian Jones
Alice Wonderland
Hedda Gabler
Norah Dollhouse

Shown Name
ghosted Number / URI
because \

nothing

has been

Cancel

entered yet.

Enter name and number or address (URI) of the new contact. After you have entered
this information, the Save field will no longer appear ghosted and you may navigate
down to this field and press the v key to save your new entry.

Alternatively, navigate down to Cancel and press the V4 key to exit the dialog box
without saving the new entry.

D14852.04 User guide Cisco TelePresence Profile, C-series codecs, Quick Set C20, SX20 Quick Set.
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Editing existing entries in the phone book

You may edit and delete entries in My contacts any time. Since updates in the
corporate phone book(s) made by your system administrator will fail to affect My
contacts, you may have to use this feature from time to time if corporate phone book
changes are made.

o PHONE BOOK

MY CONTACTS

Search Search My contacts
“ w My contacts > F Add new contact

w 0.1-Beijing Office > 10.47.148.797

w 0.2 - London Office > Adrian Jones

w 0.3 - New York Office > Alice Wonderland

w 0.4 - Oslo Office > Hedda Gabler

w 0.5-San Jose Office > Norah Dollhouse

w 0.5 - Washington Office >
Open the phone book by pressing the 1] key Navigate to the entry to be edited
and then navigate to My contacts. Press the V' and press the V/ key.

key to open My contacts.

You may call the entry directly.

9 hedda.gabler@somecompany.com

hedda.gabler@somecompany.com

lCall >

Edit before call >

You may edit the number or URI.

You may add the entry to participants list when setting up a
conference.

If the entry is listed with more dialing methods than the default, you
may use this to, for example use H.323 instead default SIP (or the
other way around).

Add to participant list >

EDIT CONTACTS

You may remove the entry from the list. Name l Hedda Gabler N
You may edit contact details. \ Number / URI | hedda.gabler@some

Remove from list >

Edit contact details

Cancel
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Sharing contents

© Make sure the PC does not cover your line of sight to any of the microphones.

General recommendations tips for making your video meeting room as good as This will reduce the perceived audio quality at the far end.
possible are described in the Administrator guide for this product. The Administrator
guide may be downloaded from www.cisco.com/go/telepresence/docs. @ Locate the DVI cable and connect the PC to the video system.

Connect the audio mini-jack output from the PC, or any other
source—including Ipod—to the mini-jack socket of the cable to
. get sound. Connect the RCA connectors to the corresponding
Dual video stream sockets on the codec/endpoint.
With dual video stream you can view two different live video streams simultaneously— ©
the main video and one additional source. This could for example be both a PC
presentation and the person who gives the presentation.

If a video system does not support dual video stream, no second video stream will be The DVI/VGA input is compliant with VESA Extended Display
established for this system and the PC presentation will be shown as the main video. Identification Data (EDID) and will be able to notify the PC of the
supported output formats.

The default presentation source will be activated when you press
the Presentation button () on the remote control, as outlined.

- Normally you must press a special key combination to switch the PC image from the PC
screen to the video screen.

- Check that the presentation source is correctly defined. Access to this setting may be
password protected by your system administrator. The procedure is described in the
Administrator guide for this product.

- Make sure your PC is set to activate your VGA output.

To specify which source to serve as presentation source select it as shown here. Note that
the name of each source can be changed, consult your administrator for details on this. All
options shown are not available to all systems.

%
5
5

PRESENTATION

5
Y

& ca

I

Secondary camera (no signal)

l |\

Py )
" Meetings

q Presentation

1EG
=

i
S

PC -

>
\
\

DvVD

& Camera control

x Settings

Document camera

® O O O O

No presentation

> %
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Controlling the cameras

During a call, you may control where your own camera is pointing (i.e. pan and tilt)
and the zoom. However, far end systems with remotely controllable cameras may

Making calls

also permit you to control their camera’s panning and zooming. This is called Far end

camera control.

© Inacall use the Arrow keys of the remote control to enter the camera
control mode. Softbuttons will now appear as shown below.

@ Use the Arrow keys and the Zoom keys to pan, tilt and zoom your
camera.

9 Exit the mode when finished.

NEAR END CAMERA CONTROL

g
Far end Camera presets

Camera settings Main source

Access to far Access to your Access to your Access to your
end camera (if own camera own camera’s  own system’s
far end camera presets, if settings. main source

is remotely defined. setting.
controllable).

Exit this
mode.

Phone book usage

Cisco TelePresence System Profile-series, C-series codecs, Quick Set C20, SX20 Quick Set

In-call features Scheduled meetings

User guide

Advanced settings

For video conferences with more than two participants, far end is an ambiguous term.
If you are the initiator of a conference the only far end camera controllable by you will
be the first participant you called. The other participants may all control your camera,

but they cannot control each other.

© Inacall use the Arrow keys of the remote control to enter the camera
control mode. Softbuttons will now appear as shown below.

@ Press the leftmost Function key to access the far end camera.
9 Proceed as for near end camera control.

FAR END CAMERA CONTROL

Back to near end
camera control.

Nolsl ®
A
BT}
/'

Exit this
mode.
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Joining a meeting

Your system may be connected to a management system capable of scheduling
meetings for your video systems. Any meetings scheduled will then appear in the Table of
Meetings as outlined below. You cannot navigate in that table with the remote control. To
produce a list in which you can navigate with the remote control, see P “Displaying a list
of upcoming meetings” on the next page.

The Table of Meetings contains 14 days of scheduled meetings. The list is sorted
using Grouping headers. The main grouping category is by day (e.g.: TODAY,
TOMORROW, then WEDNESDAY, July 20, 2011 etc).

On your video system the Meeting Reminder will appear once it is possible to join a
meeting. Exactly when that will be depends on the Start time buffer setting, which
has been set by your system administrator. Default buffer setting is 10 minutes.

The meeting reminder contains a time indicator stating when the meeting starts, or
alternatively for how long the meeting has been going on (an ongoing meeting is
referred to as a Meeting in progress).

The text Starting now will be shown during a time interval spanning from 30 seconds
before to 30 seconds after the scheduled start time of the meeting.

- Select the Join meeting and press OK. This connects you to the “dial in“ address. .
- Select Snooze and press OK to temporarily hide the Reminder for 5 minutes..
- Select Dismiss and press OK to close the Reminder.

15:19 - 15:29
@
- CTS Manager

Join meeting

Shogre Example of
Dismie Table of
Meetings

Meeting details

Example of
Meeting Reminder

Cisco TelePresence System Profile-series, C-series codecs, Quick Set C20, SX20 Quick Set

Phone book usage

User guide

In-call features

Scheduled meetings

Learning more about a meeting

Advanced settings

You may use the Reminder to learn more about the announced meeting—just navigate
down to Meeting details and expand the item.

Meeting details will typically include who the organizer is; whether the meeting will be
recorded or not; a description of the meeting; whether it may be extended, if needed
(see P “Extending a scheduled meeting” on page 43 for more on this); dial in
information etc.

Observe that when a scheduled meeting appears as Private meeting it will contain
information about the organizer only. There will be no title, no expandable meeting
outline nor will there be any dial-in information.

See P the next page for an example of how the Meeting details are presented.

- In the Reminder navigate down to Meeting details and expand this menu item to see
meeting details. An example of Meeting details is shown on the next page.

15:19 - 15:29
@
- CTS Manager

Join meeting
Snooze

Dismiss

Meeting details
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Displaying a list of upcoming meetings

If you want to take a closer look on any of the upcoming meetings including your video
system, you will need to look in a List of Meetings that lets you navigate in it with the
remote control.

Otherwise this list is identical to the table of upcoming meetings, as can be seen below.

In the Home menu, navigate down Meetings and expand the item to produce a List of
Meetings.

il
€i5€0.

MEETINGS

0 minute(s) 1645

MEETINGS

Meeting 1
Slarting in 10 minuleis) 18:45 - 1658

Meeling 2
1835~ 1645

Meeting 3
1635 - 1848

Meeting &
1635 - 1645

Phone book usage

User guide

Advanced settings
Meeting details of any upcoming meeting

In-call features

Once you have selected one of the upcoming meetings in the list, you may look into
the details of that meeting.

Even from this menu you may join the meeting, provided that you are inside the time
window allowing you to join. The length of this time window depends on the Start
time buffer defined by your system administrator. See P the previous page for more
on this.

An upcoming meeting will be shown in the Meeting Reminder, which pops up by itself
on the screen, see P the previous page for more on this.

1. Navigate to the meeting to be looked into and expand the menu item.
2. Then navigate down to Meeting details and expand this menu item to see meeting details.

bl
<isco

MEETINGS

g in 10 minutels) 16

Organizer CTS Manager

Meeting 1 Meeting 1 14:45 - 16:55
Slarting in 10 minulefs) 16451685 = - R o
Starting in 10 minule(s) @ pescription Test OBTP

Qrganizer: €S Managey Mealing ExtensionGuaranteed

Meeling 2 - Available

16,35 - 1645 Cisca Telepresence System

Maeting details RS Call-In Number 1234

Meeting 3
1435 - 1845

Meeting &
1635 - 1645
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Joining when already in a call Parallel meetings (concurrency)
If you already are in a call (a video meeting), the Join meeting field will change to reflect When Parallel meetings occur (two or more meetings taking place simultaneously), an
the new situation. alert will appear, as outlined.

Selecting View meetings followed by pressing OK will produce the List of Meetings,
with the parallel meetings shown at the top of the list as outlined below.

If you already are in a call, the Join meeting button will change to JOIN & END CURRENT. 1. Expand View meetings as outlined.

Select JOIN & END CURRENT button to join the new meeting, ending the current. 2. Then navigate down to the meeting you want to join and join in the usual way.
Select Join & Hold Current to temporarily join the meeting.

Select Snooze to temporarily hide the Reminder for 5 minutes.

Select Dismiss to go on with your current meeting.

- You can always look into the meeting details to help you make up your mind, select
Meeting details for this.

il
€i5€0.

31

MEETINGS ZJ i b
i meeting(s) about to Mesiing 1 !
B start Inprogress 14:39 - 1649
Meeling 2 i
In pragress 1639 - 16:49
-~
(;\ 6 5 I View meetings
e = Meeling 3 .
- 1839 - 1649
Meeting 1 16:06 - 16:16 0 A Snooze
In progress @ Dismiss
Organizer: CTS Manager Meeling &
* o 1639 - 1649 E
Join meeting and end current o))
(@Is[=
. \
. = | R Meeting & 5
B 1639~ 1649
Dismiss ,
=
Meating details
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Extending a scheduled meeting

Scheduled meetings have a fixed start and end time. When you are in a scheduled
meeting, a Meeting will end notification appears 10 minutes, 5 minutes and 2 minutes
before the meeting is brought to an end by the management system.

You may want to extend an ongoing meeting. This will be accepted by the system
provided that no other meeting is scheduled on the video system during the period of
extension.

If an extension is sustainable, the Meeting will end notification will include an Extend and
a Dismiss option.

- To extend a meeting, make sure the Extend field is selected, as outlined, and then press
OK.

If you do not want to extend the meeting, navigate to Dismiss and press OK.
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Chapter 6
Advanced settings
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About the Administrator settings

The Advanced configuration settings are aimed at system administrators only and may

The Administrator settings lets you define extra softbutton functions; change the IP have been password protected by your system administrator. Unless you are the system
settings of the system; use the advanced configuration options and change the menu administrator you should normally leave these settings as they are.

access password. The IP settings (not shown) are also aimed at system administrators.

Your video system can be configured through its web interface, but it may also be The Advanced configuration settings and the IP settings are described in the Administrator
configured through the Advanced configuration. This is all normally done by your Guide applying to your video system. This guide can be downloaded from www.cisco.com/
system administrator, who may have password protected the access to the Advanced go/telepresence/docs.

configuration. The password may not have been set. If you decide to give your system a password, take

care. If you forget your password contact your Cisco representative for help.

SETTINGS

Layout IS Layout

(’ Call

ki .
_ * ! Meetings

Main source: Camera > Main source: Camera >

Call settings > Call settings >

Language: English > Language: English >

Q Presentation

é Camera control

N\
A Settings

Date and time

ADMINISTRATOR PASSWORD

Date and time 4

Sounds and alerts i >

Please enter your
Administrator password:

Wallpaper: Growing >

ok

System information

Starting from the Home menu, Adminisirator settings >

navigate down to Settings and

Restart

Cancel

press the v/ key.
Then navigate to Administrator settings Enter the password. Invoke the virtual keyboard, if
and press the V/ key again to display the needed (see “Placing calls by specifying the name,
options available. number or address” on page 24 for details on this).
Navigate to OK to enter the Administrator settings menu.
D14852.04 User guide Cisco TelePresence Profile, C-series codecs, Quick Set C20, SX20 Quick Set. 45 .
All contents are copyright © 2010-2013 Cisco Systems, Inc. All rights reserved. TC 6.1 06.2013 4 > www.cisco.com


www.cisco.com/go/telepresence/docs
www.cisco.com/go/telepresence/docs

aifrar]
CISCO.

Contents

Getting started

Assigning softbutton functions

The Function keys of the system’s remote control are used to control the softbuttons
appearing along the lower end of the screen—see also P> "Navigating in the menus”

on page 6 for more.

xr o1l

SETTINGS

Layout
Main source: Camera >

Call settings

Programmable softbuttons

Audio input levels

Connect to Cisco Callway

IP settings

Set menu password

Pairing >

Advanced configuration

Navigate to Programmable softbuttons, as outlined, and
press the V/ key. Se also the previous page, if needed.

S e |

SETTINGS

Layout
Main source: Camera >

Call settings

Softbutton 1: Not set

Softbutton 2: Not set

Softbutton 3: Not set

Softbutton 4: Not set

Softbutton 5: Not set 4

Navigate to select which softbutton to assign a function

to. Press the V/ key.

Making calls

Cisco TelePresence System Profile-series, C-series codecs, Quick Set C20, SX20 Quick Set

Phone book usage In-call features

User guide

Scheduled meetings Advanced settings

The softbuttons are context sensitive, which means that they appear only when
needed and not else. You may enhance your system’s perceived performance by

assigning your own functionalities to the softbuttons.

SETTINGS

Layout

Main source: Camera >

Call settings

Programmable softbuttons

Audio input levels

Connect to Callway

SYSTEM MODE

Inidle

In call

Navigate to select whether the softbutton function shall
apply to idle or to in-call conditions. Press the v/ key.

SETTINGS

Layout

Main source: Camera >

Call settings

audi Softbutton 1: Not set
Main source selection
Camera preset

Speed dials

Select among the options available and press the V/ key. The
options are presented in detail on the following pages.

If you want a softbutton assignment to apply
to both idle and in-call situations, you must
assign a function twice.

There must be one setting for idle and
another one for in-call mode.

Note that any softbutton may be assigned to
any of the functions available.

Consequently, setting one softbutton to a
specific function for idle situations does
not require that the same function must be
assigned to the same softbutton for in-call
situations.

However, doing so may appear more logical in
many cases.

A

The description presented on this page
assumes that you are already inside the
Administrator settings, as described on the
previous page.

The access to the Administrator settings
may have been password protected by your
system administrator. Contact your system
administrator, if in doubt.
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Creating softbutton for Main source selection Creating softbutton for Camera Preset

If you want direct access (via the softbuttons along the bottom line of the screen) to If you want direct access (via the softbuttons along the bottom line of the screen) to
the source used, you should assign the function Main source selection to one of the predefined camera presets, you should assign the function Camera preset to one or
softbuttons. Below we use Softbutton 1 as an example, but the function may, of course, more of the softbuttons.

be assigned to any of the five softbuttons. Note that camera presets must have been defined before you start assigning presets

to any of the softbuttons—see P “Camera presets” on page 9 for more on
camera presets.

Below we use Softbutton 4 as an example, but the function may, of course, be
assigned to any of the five softbuttons

W w0

How to get to the menus shown below If you have set Softbutton 1 to PC as main

left and below right is described on source, you may want to set Softbutton 2 to

the previous page. Camera (or the other way around) in order to
be able to conveniently switch between the
two.

Assigning Main source selection softbutton Assigning Camera preset softbutton

SETTINGS

Layout

Main source: Camera

SETTINGS

Call settings
Layout

Main source: Camera

Call settings

fect Softbutton 1: Not set >

SOFTBUTTON 1

Main source selection >

Con

MAIN SOURCE SELECTION

Camera SOFTBUTTON 4

PC CAMERA PRESET SELECTION

Zoom out

The number of sources
available will depend on
your system.

Whiteboard

D14852.04 User guide Cisco TelePresence Profile, C-series codecs, Quick Set C20, SX20 Quick Set. 4
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Softbutton—Speed dials Customized softbuttons—how they appear

If you want direct access (via the softbuttons along the bottom line of the screen) to The below illustration shows how the video system screen may look with five
contacts in the phone book, you should assign the function Speed dials to one or more customized softbuttons defined.
of the softbuttons.

Note that assignments can be made to existing contacts only (My contacts as well as
the corporate phone book). To add a contact to your list of contacts, see P page 34.

Below we use Softbutton 5 as an example, but the function may, of course, be
assigned to any of the five softbuttons.

71\

How to get to the menu shown below is described two pages back.

Assigning Camera preset softbutton Example of customized softbuttons

SETTINGS

Layout

Main source: Camera PHONE BOOK

Search

My contacts

0.1- Beijing Office

0.2 - London Office

0.3 - New York Office
0.4 - Oslo Office

0.5 - San Jose Office
0.5 - Washington Office

Call settings

SOFTBUTTON 5

Speed dials >

E £ B B E EE
Y VY VY VYVY Vvy
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Softbutton—Clearing softbuttons

You may clear softbuttons that you no longer want to appear. This is done via the

Clear softbutton at the bottom of the menu. You do not have to clear a softbutton ;\”f Make sure you select the right softbutton (idle mode or in-call mode).
function before assign the same softbutton to another function. That may be done

right away.

For more on how to get to the below menu—see P “Assigning softbutton functions”
on page 46 for details.

SETTINGS

Layout

Main source: Camera >

Call settings

Softbutton 1: Not set

Main source selection

Camera preset

%ﬂﬂ(fl"\l

Speed dials

Clear softbutton
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THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS

IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL
STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL
ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT
WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL
RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE
ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET
THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY
THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE
OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A
COPY.

The Cisco implementation of TCP header compression is an adaptation of a
program developed by the University of California, Berkeley (UCB) as part of
UCB'’s public domain version of the UNIX operating system. All rights reserved.
Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT
FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED “AS IS” WITH
ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL
WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION,
THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR
TRADE PRACTICE.

IN'NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY
INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES,
INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO
DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN
IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

Cisco and the Cisco Logo are trademarks of Cisco Systems, Inc. and/or its
affiliates in the U.S. and other countries. A listing of Cisco’s trademarks can
be found at www.cisco.com/go/trademarks. Third party trademarks mentioned
are the property of their respective owners. The use of the word partner does
not imply a partnership relationship between Cisco and any other company.
(1005R)

Any Internet Protocol (IP) addresses and phone numbers used in this document
are not intended to be actual addresses and phone numbers. Any examples,
command display output, network topology diagrams, and other figures
included in the document are shown for illustrative purposes only. Any use of
actual IP addresses or phone numbers in illustrative content is unintentional and
coincidental.

Phone book usage In-call features Scheduled meetings Advanced settings

i
CISCO.

On our web site you will find an overview of the worldwide Cisco
contacts.

Go to: http://www.cisco.com/web/siteassets/contacts/index.html

Corporate Headquarters
Ciso Systems, Inc.
170 West Tasman Dr.
San Jose, CA 95134 USA
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